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Introduction

In this tutorial a headphone is simulated in a typical measurement setup. As headphones 
are closely coupled to the ear, it is not representative to measure their sensitivity in an 
acoustic free-field in the classical setup used for loudspeakers. The measurement requires 
the use of artificial heads and ears to accurately represent the usage conditions. This model 
shows the coupling of a circumaural headphone to a generic artificial ear.

To model all components in a headphone, this tutorial uses several physics and features. 
The foam is modeled with the Poroelastic Waves interface and coupled to Pressure 
Acoustics, Frequency Domain interface for the air domains. The Interior Perforated Plate 
condition is used to model the perforated plates and meshes in the headphone casing. The 
artificial ear is coupled to a simplified ear canal and the impedance of the ear drum is 
specifically considered in the model. The dynamic speaker driver is modeled through a 
lumped approach following Ref. 1.

Lumped representations of drivers are well known and widely used in the industry. The 
parameters that characterize the low-frequency performance of a loudspeaker, commonly 
known as the Thiele-Small or the small-signal parameters, are obtained from Ref. 2. This 
lumped model is coupled to the 3D Pressure Acoustics model describing the surrounding 
air domain. 

Note: Many of the working principles of the lumped speaker model are described in the 
Lumped Loudspeaker Driver model. Application Library path Acoustics_Module/
Electroacoustic_Transducers/lumped_loudspeaker_driver. 

Model Definition

G E O M E T R Y

A schematic section of the model is shown in Figure 2. The pinna (peach color) is obtained 
from a 3D scan of an actual human ear. The ear canal has been idealized as a cylinder of 
7.5 mm diameter and 19.8 mm length. The pinna and ear canal have been rotated to 
maintain the headphone oriented in global coordinates. The acoustic domain is shown in 
three regions; the pressure chamber (blue) the external domain (light blue) and the 
perfectly matched layer domain (dark blue). The driver is included in the model as its 
lumped equivalent (Electrical Circuit interface) enforcing a velocity on the diaphragm 
(yellow line). The pressure drop across the diaphragm is coupled back to the circuit. The 
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different chambers of the acoustic domain are connected through perforated plates (green 
lines). The headphone casing (gray) is considered as rigid (the model can be extended to 
model the casing as an elastic structure). The foam (red) is a Poroelastic Waves domain 
completely fixed on the boundaries attached to the skin and the headphone casing. 
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Figure 1: Schematic representation of the model. 

P A R A M E T E R S

The model parameters are given in the table below. The speeds defined in the table are 
used exclusively for the definition of the mesh size in the different domains. The value of 
272 m/s is the speed of the fast pressure waves in the poroelastic waves (PELW) domain. 
The maximum mesh size hmax is in general given by

where ci represents all the wave speed present in a model and f is the frequency. In a pure 
fluid there is just one speed of sound. By using the speed of the fast pressure waves in the 
PELW domain, we will be under-resolving the slow pressure waves and the shear waves in 

hmax
1
5
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min ci( )
f

-------------------=
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the PELW domain. This is done here to reduce the model size when solving the tutorial 
model. Ideally, the mesh should consider the minimum of the of the pressure waves speeds 
(variables pelw.cp_fast and pelw.cp_slow) and shear waves (variable pelw.cs_poro) 
in the PELW domain. 

VARIABLE VALUE DESCRIPTION 

 fmax 20.0 kHz Maximal frequency

 cair 343 m/s Speed of sound in air

 cporo 272 m/s Speed of wave to be resolved by the mesh 
(here the fast pressure wave speed in the 
PELW domain)

The model includes the driver of the headphone through a lumped equivalent. Thiele-
Small parameters obtained from Ref. 2 are used in this model and listed in the table below.

VARIABLE VALUE DESCRIPTION 

 Rg 0.8 Ω Cable resistance

 ne 0.7 Voice coil loss factor

 RE 124.3 Ω Voice coil resistance

  LE 5.53 mH Voice coil inductance (constant)

 CMS 2.51·10-3 m/N Suspension compliance

 RMS 12.9·10-3 N·s/m Suspension mechanical losses

 MMD 314.9 μg Moving mass (voice coil and diaphragm)

 BL 4.56 T·m Force factor, flux density (B) times coil 
length (L)

 V0 200 2  mV Driving voltage (peak)

The model includes a set of perforated plates connecting the different chambers of the 
headset. The perforated plate parameters used in the model are shown in the table below.

TABLE 1:  MODEL PARAMETERS.

TABLE 2:  THIELE SMALL PARAMETERS.

TABLE 3:  PERFORATED PLATE PARAMETERS.

VARIABLE VALUE DESCRIPTION 

 Radp1 10 mm Radius of the perforated plate 1

 n1 1 Number of circles defining the plate 1

 dh1 0.5 mm Diameter of the holes in plate 1

 tp1 0.5 mm Thickness of perforated plate 1

 Nh1 150 Number of holes in the perforated plate 1
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Each of the Interior Perforated Plate condition uses an area porosity derived from the 
parameters listed previously.

The porous material parameters used are those for a generic foam with parameters taken 
from Ref. 3. The model does not include any compression or prestressing of the foam. 
Getting a general constitutive model, that predict how all porous properties change with 
local compression or deformation, is extremely difficult. To include the effects of prestress 
will typically rely on measuring the porous properties under various compression/
deformation states to get local material values. This can, for example, be achieved in 
impedance tube measurements as shown in Ref. 4, where an optimization is used to fit the 
material parameters to the test data. In general it should be noticed that good material data 
is important for the quality of numerical simulations.

B O U N D A R Y  C O N D I T I O N S

The model makes use of two of the Physiological impedance models, described in the 
Acoustics Module User’s Guide, to accurately represent the skin (Human skin) and the 
eardrum (Human ear drum).The boundaries of the model that included the skin impedance 
condition are shown in Figure 2.

 Radp2 6 mm Radius of the perforated plate 2

 n2 4 Number of circles defining the plate 2

 dh2 0.5 mm Diameter of the holes in plate 2

 tp2 0.5 mm Thickness of perforated plate 2

 Nh2 200 Number of holes in the perforated plate 2

 Radp3 6 mm Radius of the perforated plate 3

 n3 4 Number of circles defining the plate 3

 dh3 0.5 mm Diameter of the holes in plate 3

 tp3 0.5 mm Thickness of perforated plate 3

 Nh3 300 Number of holes in the perforated plate 3

TABLE 3:  PERFORATED PLATE PARAMETERS.

VARIABLE VALUE DESCRIPTION 
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Figure 2: Boundaries of the acoustic domain with skin impedance.

Details about the lumped driver approach used in this model are found in the Lumped 
Loudspeaker Driver model and in the Modeling Instructions below. The perforated plates 
of the headset modeled through the Interior Perforated Plate condition, is described in 
detail in the Acoustics Module User’s Guide in the Theory For The Interior Impedance 
Models section.
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Results and Discussion

The sound pressure level on the skin (on and around the ear) at four different frequencies 
is shown in Figure 3. At the lowest frequencies the effect of the foam is clearly visible, 
where the large transition in SPL is seen. 

Figure 3: Sound pressure level at the skin at different frequencies.

The average sound pressure level at the eardrum is shown in Figure 4. This model has been 
solved on a high performance computer (HPC) with a finer mesh to capture the slow 
pressure waves and the shear waves. These results are imported and compared to the 
current model. The results of this finer meshed model show good agreement at low 
frequency (as all pressure waves are correctly resolved at low frequency in both models) 
but show significant differences as the frequency increases. The model requires about 
28 GB of RAM to solve with the coarse mesh (used in the model) while it requires about 
100 GB to solve with the default solver on the HPC system (single node). The model 
setup and the mesh can easily be modified to resolve all wave speed by modifying the 
parameter cporo from 272[m/s] (fast pressure wave speed) to 96[m/s] (shear wave 
speed, the slowest wave).
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Although it is not shown in this tutorial, it is possible to explore the effect the perforates/
meshes have on the on the sound pressure level by modifying the Interior Perforated Plate 
parameters.

Figure 4: Sound pressure level at the eardrum.

Notes About the COMSOL Implementation

As described previously, and in the Modeling Instructions below, only the fast pressure 
waves have been considered while choosing the mesh size in the PELW domain. This has 
been done to limit the size of the model and make sure that the model can run on a 
computer with 32 GB of RAM. The solver setup in the model uses an iterative solver while 
the fine mesh model has been solved using a direct solver. It is very important to use a tight 
relative tolerance in the stationary solver (for this model 2e-7 is a good choice) when 
working with iterative solvers. It is good practice to do a convergence analysis on the 
relative tolerance until the results remain unaltered.

The PML in the model is set up using the User defined option for the Geometry Type. This 
is the case as the automatic detection fails when the PML is only part of a cylindrical layer 
(and is cut using a complex surface). Three PML region have been defined with different 
expressions for the Distance function. One definition for the top, one for the sides, and one 
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for the corners. The distance function is a mathematical expression that describes the 
distance from the inner PML boundary to the outer boundary.
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Application Library path: Acoustics_Module/Electroacoustic_Transducers/
headphone_artificial_ear

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Model parameters in the Label text field.

3 Locate the Parameters section. Click Load from File.
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4 Browse to the model’s Application Libraries folder and double-click the file 
headphone_artificial_ear_parameters.txt.

Parameters 2
1 In the Home toolbar, click Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Perforated plates parameters in the 
Label text field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
headphone_artificial_ear_plates.txt.

Parameters 3
1 In the Home toolbar, click Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Thiele-Small Parameters in the Label 
text field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
headphone_artificial_ear_ts_parameters.txt.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

Import the model geometry from file by following these steps.

Import 1 (imp1)
1 In the Home toolbar, click Import.

2 In the Settings window for Import, locate the Import section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
headphone_artificial_ear_geometry.mphbin.

5 Click Import.

6 Click the Zoom Extents button in the Graphics toolbar.
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7 Click the Wireframe Rendering button in the Graphics toolbar.

The figure below shows the model geometry.

In the following steps we will create the selections that will be used to define the model.

D E F I N I T I O N S

Explicit 1
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Foam in the Label text field.
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3 Select Domains 15–20 only.

The selection should look like this.

Explicit 2
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Moving membrane positive in the Label text 
field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 150, 152, 156, and 158 only.

The selection should look like this.

Explicit 3
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Moving membrane negative in the Label text 
field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 151, 153, 157, and 159 only.

The selection should look like this.

Explicit 4
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Interior sound hard boundary in the Label 
text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
14 |  H E A D P H O N E  O N  A N  A R T I F I C I A L  E A R



4 Select Boundaries 126–129, 146–149, 154, 155, 160, and 161 only.

The selection should look like this.

Explicit 5
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Eardrum in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
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4 Select Boundary 333 only.

The selection should look like this.

Explicit 6
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, locate the Input Entities section.

3 From the Geometric entity level list, choose Boundary.

4 In the Label text field, type Skin with PML.
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5 Select Boundaries 289, 316–332, 334, and 335 only.

The selection should look like this.

Explicit 7
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Skin without PML in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 289, 317–322, and 324–328 only.

The selection should look like this.

Explicit 8
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type PML sides in the Label text field.
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3 Select Domains 3, 4, 22, and 25 only.

The selection should look like this.

Explicit 9
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type PML corners in the Label text field.
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3 Select Domains 1, 2, 5, 6, 21, 23, 24, and 26 only.

The selection should look like this.

Explicit 10
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type PML caps in the Label text field.
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3 Select Domains 7 and 9 only.

The selection should look like this.

Explicit 11
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Perforated plate 1 in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
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4 Select Boundary 32 only.

The selection should look like this.

Explicit 12
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Perforated plate 2 in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 88, 95, 98, and 113 only.

The selection should look like this.

Explicit 13
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Perforated plate 3 in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 272, 273, 282, and 283 only.

The selection should look like this.

Explicit 14
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type All Domains in the Label text field.

3 Locate the Input Entities section. Select the All domains check box.

Explicit 15
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Plastic casing in the Label text field.
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3 Select Domains 10 and 12 only.

The selection should look like this.

Difference 1
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Air with PML in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog box, select All Domains in the Selections to add list.

5 Click OK.

6 In the Settings window for Difference, locate the Input Entities section.

7 Under Selections to subtract, click Add.

8 In the Add dialog box, in the Selections to subtract list, choose Foam and Plastic casing.

9 Click OK.

Difference 2
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Air without PML in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog box, select Air with PML in the Selections to add list.
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5 Click OK.

6 In the Settings window for Difference, locate the Input Entities section.

7 Under Selections to subtract, click Add.

8 In the Add dialog box, in the Selections to subtract list, choose PML sides, PML corners, 
and PML caps.

9 Click OK.

Union 1
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Air boundaries in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog box, in the Selections to add list, choose Eardrum, Skin with PML, 
Perforated plate 1, Perforated plate 2, and Perforated plate 3.

6 Click OK.

Union 2
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Moving membrane in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog box, in the Selections to add list, choose Moving membrane positive and 
Moving membrane negative.

6 Click OK.

Difference 3
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Meshed domains without PML and foam 
in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog box, select All Domains in the Selections to add list.

5 Click OK.

6 In the Settings window for Difference, locate the Input Entities section.

7 Under Selections to subtract, click Add.
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8 In the Add dialog box, in the Selections to subtract list, choose Foam, PML sides, 
PML corners, PML caps, and Plastic casing.

9 Click OK.

Union 3
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type PML in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog box, in the Selections to add list, choose PML sides, PML corners, and 
PML caps.

5 Click OK.

Integration 1 (intop1)
1 In the Definitions toolbar, click Nonlocal Couplings and choose Integration.

2 In the Settings window for Integration, type Integration on the moving membrane 
in the Label text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose 
Boundary.

4 From the Selection list, choose Moving membrane.

Variables 1
1 In the Model Builder window, right-click Definitions and choose Variables.

2 In the Settings window for Variables, type Model variables in the Label text field.

3 Locate the Variables section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
headphone_artificial_ear_variables.txt.

A D D  P H Y S I C S

1 In the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select AC/DC>Electrical Circuit (cir).

4 Click Add to Selection in the window toolbar.

5 In the Home toolbar, click Add Physics to close the Add Physics window.
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E L E C T R I C A L  C I R C U I T  ( C I R )

Voltage Source V1
1 Right-click Component 1 (comp1)>Electrical Circuit (cir) and choose Voltage Source.

2 In the Settings window for Voltage Source, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the Vsrc text field, type V0.

Resistor R1
1 In the Electrical Circuit toolbar, click Resistor.

2 In the Settings window for Resistor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type R_g.

Resistor R2
1 In the Electrical Circuit toolbar, click Resistor.

2 In the Settings window for Resistor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type R_E.

Inductor L1
1 In the Electrical Circuit toolbar, click Inductor.

2 In the Settings window for Inductor, locate the Node Connections section.

Label Node names

n 0

Label Node names

p 1

n 2

Label Node names

p 2

n 3
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3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the L text field, type L_E.

Resistor R3
1 In the Electrical Circuit toolbar, click Resistor.

2 In the Settings window for Resistor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type Rp_E.

Inductor L2
1 In the Electrical Circuit toolbar, click Inductor.

2 In the Settings window for Inductor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the L text field, type M_MD[H/kg].

Current-Controlled Voltage Source H1
1 In the Electrical Circuit toolbar, click Current-Controlled Voltage Source.

2 In the Settings window for Current-Controlled Voltage Source, locate the 
Node Connections section.

3 In the table, enter the following settings:

Label Node names

p 3

n 4

Label Node names

p 3

n 4

Label Node names

p 6

n 7

Label Node names

p 4

n 0
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4 Locate the Device Parameters section. From the Measure current for device list, choose 
Inductor L2.

Current-Controlled Voltage Source H2
1 In the Electrical Circuit toolbar, click Current-Controlled Voltage Source.

2 In the Settings window for Current-Controlled Voltage Source, locate the 
Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the Gain text field, type BL[m/Wb*ohm].

5 From the Measure current for device list, choose Resistor R2.

Resistor R4
1 In the Electrical Circuit toolbar, click Resistor.

2 In the Settings window for Resistor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type R_MS[ohm/kg*s].

Capacitor C1
1 In the Electrical Circuit toolbar, click Capacitor.

2 In the Settings window for Capacitor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the C text field, type C_MS[F*N/m].

Voltage Source V2
1 In the Electrical Circuit toolbar, click Voltage Source.

2 In the Settings window for Voltage Source, locate the Node Connections section.

Label Node names

p 6

n 0

Label Node names

p 7

Label Node names

p 8
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3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the Vsrc text field, type -F_D[V/N].

C O M P O N E N T  1  ( C O M P 1 )

In the Home toolbar, click Windows and choose Add Physics.

A D D  P H Y S I C S

1 Go to the Add Physics window.

2 In the tree, select Acoustics>Pressure Acoustics>Pressure Acoustics,

 Frequency Domain (acpr).

3 Click Add to Selection in the window toolbar.

4 In the Model Builder window, click Component 1 (comp1).

5 In the Home toolbar, click Add Physics to close the Add Physics window.

P R E S S U R E  A C O U S T I C S ,  F R E Q U E N C Y  D O M A I N  ( A C P R )

1 In the Settings window for Pressure Acoustics, Frequency Domain, locate the 
Domain Selection section.

2 From the Selection list, choose Air with PML.

Impedance 1
1 In the Physics toolbar, click Boundaries and choose Impedance.

2 In the Settings window for Impedance, type Eardrum Impedance in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Eardrum.

4 Locate the Impedance section. From the Impedance model list, choose Physiological.

5 From the list, choose Human ear drum.

Impedance 2
1 In the Physics toolbar, click Boundaries and choose Impedance.

2 In the Settings window for Impedance, type Skin impedance in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Skin with PML.

4 Locate the Impedance section. From the Impedance model list, choose Physiological.

The selection should look like Figure 2.

Label Node names

p 9

n 0
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Interior Sound Hard Boundary (Wall) 1
1 In the Physics toolbar, click Boundaries and choose Interior Sound Hard Boundary (Wall).

2 In the Settings window for Interior Sound Hard Boundary (Wall), locate the 
Boundary Selection section.

3 From the Selection list, choose Interior sound hard boundary.

Interior Perforated Plate 1
1 In the Physics toolbar, click Boundaries and choose Interior Perforated Plate.

2 In the Settings window for Interior Perforated Plate, locate the Boundary Selection 
section.

3 From the Selection list, choose Perforated plate 1.

4 Locate the Interior Perforated Plate section. In the dh text field, type dh1.

5 In the tp text field, type tp1.

6 In the σ text field, type sigma1.

Interior Perforated Plate 2
1 In the Physics toolbar, click Boundaries and choose Interior Perforated Plate.

2 In the Settings window for Interior Perforated Plate, locate the Boundary Selection 
section.

3 From the Selection list, choose Perforated plate 2.

4 Locate the Interior Perforated Plate section. In the dh text field, type dh2.

5 In the tp text field, type tp2.

6 In the σ text field, type sigma2.

Interior Perforated Plate 3
1 In the Physics toolbar, click Boundaries and choose Interior Perforated Plate.

2 In the Settings window for Interior Perforated Plate, locate the Boundary Selection 
section.

3 From the Selection list, choose Perforated plate 3.

4 Locate the Interior Perforated Plate section. In the dh text field, type dh3.

5 In the tp text field, type tp3.

6 In the σ text field, type sigma3.

Interior Normal Velocity 1
1 In the Physics toolbar, click Boundaries and choose Interior Normal Velocity.

2 In the Settings window for Interior Normal Velocity, locate the Boundary Selection section.
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3 From the Selection list, choose Moving membrane.

4 Locate the Interior Normal Velocity section. Specify the v0 vector as

C O M P O N E N T  1  ( C O M P 1 )

In the Home toolbar, click Windows and choose Add Physics.

A D D  P H Y S I C S

1 Go to the Add Physics window.

2 In the tree, select Acoustics>Elastic Waves>Poroelastic Waves (pelw).

3 Click Add to Selection in the window toolbar.

4 In the Model Builder window, click Component 1 (comp1).

5 In the Home toolbar, click Add Physics to close the Add Physics window.

P O R O E L A S T I C  W A V E S  ( P E L W )

1 In the Settings window for Poroelastic Waves, locate the Domain Selection section.

2 From the Selection list, choose Foam.

Fixed Constraint 1
1 In the Physics toolbar, click Boundaries and choose Fixed Constraint.

2 Select Boundaries 260, 262, 265, 274, 278, 284, 318–322, and 326 only.

Poroelastic Material 1
1 In the Model Builder window, click Poroelastic Material 1.

2 In the Settings window for Poroelastic Material, locate the Poroelastic Model section.

3 From the Model list, choose Biot-Allard (thermal and viscous losses).

M U L T I P H Y S I C S

Acoustic-Porous Boundary 1 (apb1)
1 In the Physics toolbar, click Multiphysics Couplings and choose Boundary>Acoustic-

Porous Boundary.

2 In the Settings window for Acoustic-Porous Boundary, locate the Boundary Selection 
section.

-u_D x

0 y

0 z
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3 From the Selection list, choose All boundaries.

The following steps define the PML used in the model. The number of stretching 
directions and the distance function are defined manually to make sure that the PML 
works as intended.

Perfectly Matched Layer 1 (pml1)
1 In the Definitions toolbar, click Perfectly Matched Layer.

2 In the Settings window for Perfectly Matched Layer, locate the Domain Selection section.

3 From the Selection list, choose PML sides.

4 Locate the Geometry section. From the Type list, choose User defined.

5 In the table, enter the following settings:

Perfectly Matched Layer 2 (pml2)
1 In the Definitions toolbar, click Perfectly Matched Layer.

2 In the Settings window for Perfectly Matched Layer, locate the Domain Selection section.

3 From the Selection list, choose PML caps.

4 Locate the Geometry section. From the Type list, choose User defined.

5 In the table, enter the following settings:

Perfectly Matched Layer 3 (pml3)
1 In the Definitions toolbar, click Perfectly Matched Layer.

2 In the Settings window for Perfectly Matched Layer, locate the Domain Selection section.

3 From the Selection list, choose PML corners.

4 Locate the Geometry section. From the Type list, choose User defined.

5 From the Number of stretching directions list, choose 2.

Distance function (m) Thickness (m)

Direction 1 sqrt((x-40[mm])^2+(y-50[mm])^2)-
60[mm]

5[mm]

Distance function (m) Thickness (m)

Direction 1 abs(z)-65 [mm] 5[mm]
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6 In the table, enter the following settings:

M A T E R I A L S

In the Home toolbar, click Windows and choose Add Material from Library.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-in>Air.

3 Click Add to Component in the window toolbar.

M A T E R I A L S

Air (mat1)
1 In the Settings window for Material, type Air - Domains in the Label text field.

2 Locate the Geometric Entity Selection section. From the Selection list, choose 
Air with PML.

P O R O E L A S T I C  W A V E S  ( P E L W )

Poroelastic Material 1
1 In the Model Builder window, under Component 1 (comp1)>Poroelastic Waves (pelw) click 

Poroelastic Material 1.

2 In the Settings window for Poroelastic Material, locate the Fluid Properties section.

3 From the Fluid material list, choose Air - Domains (mat1).

M A T E R I A L S

In the Home toolbar, click Windows and choose Add Material from Library.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-in>Air.

3 Click Add to Component in the window toolbar.

Distance function (m) Thickness (m)

Direction 1 sqrt((x-40[mm])^2+(y-50[mm])^2)-
60[mm]

5[mm]

Direction 2 abs(z)-65 [mm] 5[mm]
35 |  H E A D P H O N E  O N  A N  A R T I F I C I A L  E A R



M A T E R I A L S

Air (mat2)
1 In the Settings window for Material, type Air - Boundaries in the Label text field.

2 Locate the Geometric Entity Selection section. From the Geometric entity level list, 
choose Boundary.

3 From the Selection list, choose Air boundaries.

Material 3 (mat3)
1 In the Model Builder window, right-click Materials and choose Blank Material.

2 In the Settings window for Material, type Foam in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose Foam.

4 Locate the Material Contents section. In the table, enter the following settings:

5 In the Home toolbar, click Add Material to close the Add Material window.

Now proceed to generate the mesh. Change the meshing method to manual to make 
sure that the model is correctly resolved in the frequency range and reduce the running 
time of the model.

Property Variable Value Unit Property group

Poisson’s ratio nu 0.3 1 Basic

Shear modulus G 110[kPa] N/m² Bulk modulus and 
shear modulus

Density rho 41[kg/
m^3]

kg/m³ Basic

Porosity epsilon 0.85 1 Basic

Tortuosity factor tau 1.18 1 Poroacoustics 
model

Flow resistivity Rf 34000[N*
s/m^4]

Pa·s/m² Poroacoustics 
model

Viscous 
characteristic length

Lv 60[um] m Poroacoustics 
model

Thermal 
characteristic length

Lth 87[um] m Poroacoustics 
model

Isotropic structural 
loss factor

eta_s 0.015 1 Basic
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M E S H  1

1 In the Settings window for Mesh, locate the Mesh Settings section.

2 From the Sequence type list, choose User-controlled mesh.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
lambda_air/5.

5 In the Minimum element size text field, type 0.25 [mm].

6 In the Maximum element growth rate text field, type 1.4.

7 In the Curvature factor text field, type 0.5.

8 In the Resolution of narrow regions text field, type 1.

9 Click Build Selected.

Mapped 1
1 In the Model Builder window, right-click Mesh 1 and choose More Operations>Mapped.

2 Select Boundaries 261, 264, 267, 276, 281, and 288 only.

Size 1
1 Right-click Mapped 1 and choose Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. Select the Maximum element size check box.

5 In the associated text field, type lambda_poro/5.

Ideally, all the waves propagating in the PELW domain should be considered for the 
determination of the mesh size. In order to fit the model in a 32 GB RAM computer, 
the model consider only the fast pressure waves and will be therefore under resolve the 
slow pressure waves or the shear waves. To get all waves correctly solved, change the 
parameter cporo to the slowest wave speed in the PELW, in this case the shear waves 
with speed of 96 [m/s].

Swept 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 In the Settings window for Swept, locate the Domain Selection section.
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3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Foam.

Size 1
1 Right-click Swept 1 and choose Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. Select the Maximum element size check box.

5 In the associated text field, type lambda_poro/5.

Ideally, all the waves propagating in the PELW domain should be considered for the 
determination of the mesh size. In order to fit the model in a 32 GB RAM computer, 
the model consider only the fast pressure waves and will be therefore under resolve the 
slow pressure waves or the shear waves. To get all waves correctly solved, change the 
parameter cporo to the slowest wave speed in the PELW, in this case the shear waves 
with speed of 96 [m/s].

Free Tetrahedral 1
1 In the Model Builder window, click Free Tetrahedral 1.

2 In the Settings window for Free Tetrahedral, locate the Domain Selection section.

3 From the Selection list, choose Meshed domains without PML and foam.

Size 1
1 Right-click Free Tetrahedral 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Interior sound hard boundary.

5 Locate the Element Size section. Click the Custom button.

6 Locate the Element Size Parameters section. Select the Maximum element size check box.

7 In the associated text field, type 2.0[mm].

8 Click Build All.

Swept 2
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 In the Settings window for Swept, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose PML.
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Distribution 1
1 Right-click Swept 2 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 In the Number of elements text field, type 8.

4 Click Build All.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select General Studies>

Frequency Domain.

4 Click Add Study in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  1

1 In the Model Builder window, click Study 1.

2 In the Settings window for Study, type Study 1 - Frequency domain in the Label text 
field.

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 - Frequency domain click 

Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 Click Range.

4 In the Range dialog box, choose ISO preferred frequencies from the Entry method list.

5 In the Start frequency text field, type 20.

6 In the Stop frequency text field, type 20000.

7 From the Interval list, choose 1/3 octave.

8 Click Replace.

9 In the Study toolbar, click Get Initial Value.

S T U D Y  1  -  F R E Q U E N C Y  D O M A I N

Solver Configurations
In the Model Builder window, expand the Study 1 - Frequency domain>Solver Configurations 
node.
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Solution 1 (sol1)
1 In the Model Builder window, expand the Study 1 - Frequency domain>

Solver Configurations>Solution 1 (sol1) node.

2 Right-click Stationary Solver 1 and choose Fully Coupled.

3 In the Settings window for Stationary Solver, locate the General section.

4 In the Relative tolerance text field, type 2e-7.

It is very important to use a tight relative tolerance in the stationary solver when 
working with iterative solvers

5 Right-click Stationary Solver 1 and choose Iterative.

6 In the Model Builder window, expand the Study 1 - Frequency domain>

Solver Configurations>Solution 1 (sol1)>Stationary Solver 1>Iterative 1 node.

7 Right-click Iterative 1 and choose Multigrid.

8 In the Settings window for Multigrid, click to expand the Hybridization section.

9 From the Use as list, choose Multi preconditioner.

10 In the Preconditioner variables list, choose Pressure (comp1.p2), 
Displacement field (comp1.u), comp1.currents, comp1.voltages, and comp1.current_time.

11 Under Preconditioner variables, click Delete.

12 Right-click Iterative 1 and choose Direct Preconditioner.

13 In the Settings window for Direct Preconditioner, locate the General section.

14 From the Solver list, choose PARDISO.

15 Click to expand the Hybridization section. In the Preconditioner variables list, select 
Pressure (comp1.p).

16 Under Preconditioner variables, click Delete.

17 Click Compute.

R E S U L T S

Acoustic Pressure (acpr)
Click the Go to Default View button in the Graphics toolbar.

Table 1
1 In the Results toolbar, click Table.

2 In the Settings window for Table, type Fine_mesh_solution in the Label text field.

3 Locate the Data section. Click Import.
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4 Browse to the model’s Application Libraries folder and double-click the file 
headphone_artificial_ear_spl_detailed_results.txt.

3D Plot Group 5
1 In the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type SPL on Mannikin Surface in the Label 
text field.

3 Click to expand the Title section. From the Title type list, choose Manual.

4 In the Title text area, type Sound pressure level (dB).

5 In the Parameter indicator text field, type freq=eval(freq) Hz.

6 Select the Allow evaluation of expressions check box.

7 Locate the Plot Settings section. Clear the Plot dataset edges check box.

Surface 1
1 Right-click SPL on Mannikin Surface and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type acpr.Lp.

Selection 1
1 Right-click Surface 1 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Skin without PML.

Surface 2
1 In the Model Builder window, right-click SPL on Mannikin Surface and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type pelw.Lp.

4 Click to expand the Inherit Style section. From the Plot list, choose Surface 1.

Selection 1
1 Right-click Surface 2 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Skin without PML.

4 In the SPL on Mannikin Surface toolbar, click Plot.

The image should look like Figure 3.
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1D Plot Group 6
1 In the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Average SPL at the Eardrum in the 
Label text field.

3 Click to expand the Title section. From the Title type list, choose Manual.

4 In the Title text area, type Octave Band: Average SPL on the eardrum (Pa).

5 Locate the Legend section. From the Position list, choose Upper left.

Octave Band 1
1 In the Average SPL at the Eardrum toolbar, click More Plots and choose Octave Band.

2 In the Settings window for Octave Band, type Average SPL at the eardrum in the 
Label text field.

3 Locate the Selection section. From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Eardrum.

5 Locate the Plot section. From the Style list, choose Continuous.

6 In the Average SPL at the Eardrum toolbar, click Plot.

7 Click to expand the Legends section. Select the Show legends check box.

8 From the Legends list, choose Manual.

9 In the table, enter the following settings:

Table Graph 1
1 In the Model Builder window, right-click Average SPL at the Eardrum and choose 

Table Graph.

2 In the Settings window for Table Graph, click to expand the Legends section.

3 Select the Show legends check box.

4 From the Legends list, choose Manual.

5 In the table, enter the following settings:

6 In the Average SPL at the Eardrum toolbar, click Plot.

The image should look like Figure 4.

Legends

Average SPL at the eardrum

Legends

Fine mesh results
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